Chapter Management Guide
Contents

CHAPTER MANAGEMENT ............................................................................................................. 1
Design and Management Process .............................................................................................. 1
Chapter Management: Process Overview .................................................................................. 2
  Chapter Management Roles ...................................................................................................... 3
    Content Manager ................................................................................................................. 3
    Data Manager ...................................................................................................................... 3
    Member ............................................................................................................................... 3
    Anonymous User ................................................................................................................. 3
Pre-Design Work for Chapter Management .............................................................................. 4
  Chapter Links Part ............................................................................................................... 5
  Chapter Page Element Parts ................................................................................................. 5
Manage Chapter Pages ............................................................................................................. 6
Design Chapter Manager .......................................................................................................... 7
  Chart: Display Profile Update and Display Giving History .................................................... 16
Changes in Blackbaud CRM ..................................................................................................... 17
Chapter Management

When you add chapter management to your website, you create “subsites” within your site. You can use chapter management to implement a variety of structured segmentation at organizations. For example, an alumni association can use chapter management to create web pages for individual alumni classes or the different colleges at a school (for example, College of Architecture). If your organization has committees with committee chairs, you can implement chapter management for committee use. Chapter management can also be used to create separate web pages for city, state, or regional chapters.

Chapter management is comprised of multiple pieces from the program that, together, complete the solution. The main piece, the Chapter Manager part, is contained within your site. However, the Chapter Manager part is structured to group its pages together in a separate, subsite organization. To begin, review the Design and Management Process on page 1.

Design and Management Process

This flow chart illustrates the design and management process for chapter management.
Chapter Management: Process Overview on page 2

Chapter Management: Process Overview

Creating chapter management requires several steps in different areas of the program.

Step 1 — Designate individuals for your content manager, data manager, and member roles. See Chapter Management Roles on page 3.

Step 2 — Plan your Chapter Manager site and educate everyone involved about your plans.

Step 3 — The web designer creates the necessary parts, pages, templates, and email needed for the Chapter Manager part type. For example, if the Chapter Page Elements for the Chapter Manager do not exist, the web designer creates them. For information about Pages & templates and Layouts, see the Website Design Guide. For information about Parts, see the Parts Guide. Also see Chapter Page Element Parts on page 5.

Step 4 — The Content Manager designs the Chapter Links. See Chapter Links Part on page 5.

Step 5 — The Content Manager designs the Chapter Manager. See Design Chapter Manager on page 7.

Step 6 — Managers solicit potential members with an email appeal. The email includes information about your chapter and a link to the chapter site. See Manager tab on page 8 and Manage Chapter Pages on page 6.
Step 7 — Members visit the chapter site. They learn about your chapter and how to become active members. Members also communicate with your managers and other members of your chapter.

Step 8 — A user downloads updated profile transactions in Blackbaud CRM. Chapter members do not register for the chapter. Therefore, Blackbaud Internet Solutions does not pass additional data offline. See Changes in Blackbaud CRM on page 17.

Chapter Management Roles

Three roles exist for users of a Chapter Manager: Content Manager, Data Manager, and Member. Content Managers and Data Managers are based on Blackbaud Internet Solutions roles that you select in Roles. Members are based on a query from Blackbaud CRM. In Blackbaud Internet Solutions, you define security in Task groups. You then use security assignments to associate the roles with the task groups to apply security for chapters. As you create the Chapter Manager part, you select the roles to assign to the Content Manager, Data Manager, and Member. There is no user sign-up process for Chapter Manager; users are assigned to chapters based on roles.

For information about how to select the roles for your Chapter Manager, see Chapters tab on page 14. For information about security, see the Users & Security Guide.

Content Manager

Every Chapter Manager part has one or more Content Managers. Content Managers select a site web page template, customize the Chapter Page Element Parts on page 5, edit and update content (for example, news headlines, event calendars, and blogs), and send email to members of the chapter. These email messages can be for membership or event purposes. Typically, Content Managers are users of the administration area.

Note: Content Managers and Data Managers are based on roles that you select in Users & security. You can assign different rights to these positions or contain Content and Data Managers in a single role with the rights of both roles.

Data Manager

Every Chapter Manager part has Data Managers. Data Managers can update a member’s profile and process giving history information from the manager Home page on your site. Data Managers also manage membership and event data. Typically, Data Managers are your chapter managers (for example, a class president).

Note: Content Managers and Data Managers are based on roles that you select in Roles. For information about roles, see the Administration Guide. You can assign different rights to these positions or contain Content and Data Managers in a single role with the rights of both roles.

Member

Members are the general users of the Chapter Manager on your site. Individuals in this group can be past donors to your regional office or alumni class members. Use security to limit this role. Generally, Members are your chapter site visitors.

Note: Members are in a query from Blackbaud CRM. In Blackbaud Internet Solutions, you define security in Task groups. You then use security assignments to associate the roles with the task groups to apply security. For information, see the Users & Security Guide.

Anonymous User

Anonymous users can browse chapter site pages if you add a Menu part that includes a link to the page that
contains the chapter site search. For information about the Menu part, see the Parts Guide. The chapter site search is created on the Manager tab in the Chapter Manager part. Because it is the responsibility of a chapter manager to be involved with your site and communicate to peers through email broadcasts from your site, the identity of the chapter site visitors is likely known to you.

Note: Anonymous users might want to become members of your chapter site. Make sure to provide a way for these users to contact your organization to join. For example, you can add a statement that reads “Not a member of this chapter and would like to be? Send an email to chapter@yourdomain.org.”

Pre-Design Work for Chapter Management

Before creating a Chapter Manager, several key components must exist. The web designer creates the Chapter Manager, components are selected and used in the part. Before creating the Chapter Manager part, make sure the following pieces exist for it:

- In Blackbaud CRM, create a query of your members. In Blackbaud Internet Solutions, the query is used to assign rights for the member query role. For more information, see Chapter Management Roles on page 3.
- Establish security for the Content Manager, Data Manager, and Member positions. For information about roles, see the Users & Security Guide.
- Create a Chapter Links part to add links on the website menu for managers and members to access chapter sites. Manager and members only view links to their chapters. You should only create one Chapter Links part for your Chapter Manager part. For more information, see Chapter Links Part on page 5.
- Chapter Page Element part types are used by chapter managers to customize a chapter page on your site. Chapter Page Elements are combined with other parts to create pages that offer dynamic sections (Chapter Page Element parts) for chapter managers to customize and static sections (other parts) for your organization to create elements that cannot be edited by a manager. These pages are designed for members to communicate with other members and managers and for nonmembers to learn about your chapter and hopefully become active members in your chapter. If you select more than one page, you offer managers a set of chapter pages to customize. For example, if your organization has regional chapters, you can create multiple web pages for each chapter. Each page contains one or more Chapter Page Elements for the customization of each regional chapter page. For more information, see Chapter Page Element Parts on page 5.
- Create a web page that contains a User Email Preferences Form part if one does not already exist. With this part, a website user can subscribe or unsubscribe from email lists and opt out of email from your organization. When you create a Chapter Manager, you create an email template that managers use to generate and send email. The email requires you to create a link to a user email preferences form. For more information, see the Parts Guide.
- Create additional web pages for your chapter site. For example, you can create a static web page that cannot be edited by a chapter manager for each local chapter in your organization. For information about how to create web pages, see the Website Design Guide.
Chapter Links Part

Create a Chapter Links part to add links on the website home page for managers and members to click to access a chapter site. Managers and members only view links to their chapters. For example, Mark is the Data Manager for the Atlanta chapter. He is a part of the Atlanta Data Manager role that is used for your chapter site. When he logs in to your website, the Atlanta chapter link appears on the menu. You create only one Chapter Links part for your Chapter Manager part. For information about the Chapter Manager part, see Design Chapter Manager on page 7.

- Design Chapter Links

For information about chapter management, see Design and Management Process on page 1. For information about the Chapter Manager part, see Design Chapter Manager on page 7.

For information about creating or editing a part, as well as the tabs on the Edit Part screen, see the Parts Guide.

1. From the Design tab, in the Title field, enter a title for your link on your website. For example, enter “Class of 1981.”
2. Under Text of link, select the checkbox beside the Text field to enter text in.
   a. If you select Add text to the beginning of the chapter name, enter text in the field to prepend to the chapter name. For example, if you enter “Class of” and the chapter name in your Chapter Manager part is “1998,” your chapter link appears as “Class of 1998” on your site.
   b. If you Add text to the end of the chapter name, enter text in the field to append to the chapter name. For example, if you enter “chapter” and the chapter name in your Chapter Manager part is “Atlanta,” your chapter link appears as “Atlanta chapter” on your site.
3. In the Preview frame, view the text you entered in the previous step. Confirm the Link Text appears as you want it to on your Chapter Links part.
4. Click Save. You return to Parts.

Chapter Page Element Parts

Create Chapter Page Elements to add dynamic and customizable sections to a web page for chapter use. These web pages communicate the chapter’s purpose and facilitate interaction among members. Members of the chapter visit the page to learn more about the manager’s involvement with your chapter and to become involved in your organization.

When you create a Chapter Manager part, you select the possible web pages with Chapter Page Elements to include on your site. If you select more than one page, you offer managers a set of chapter pages to customize. For example, if your organization has multiple regional chapters, you can create one or more web pages for each chapter. Each page contains one or more Chapter Page Element for the customization of each regional chapter page.

Web pages that use Chapter Page Elements also contain static sections that are other parts. Use these sections to create defaults for your organization that appear on every chapter page. For example, you can include your chapter mission statement on the chapter page. The mission statement is contained in a Formatted Text and Images part.

Review the following graphic for a web page that uses Chapter Page Elements and other static parts.
Chapter Page Element parts can be one of several element types. The page element types are Action, Directory, Event Calendar, News, News Reader, Photos, Rich Text, or Text.

For information about how to create Chapter Page Element types, see the Parts Guide.

Manage Chapter Pages

When you add a Chapter Manager part to a page on your website, chapter managers can manage chapter pages. The Home page dashboard provides a central location for chapter managers to monitor their pages.

The action bar on the Home page dashboard allows chapter managers to navigate between tasks, monitor and update data, edit chapter pages, send email, and search for chapter members.

- **Home** — To monitor their pages and perform tasks, chapter managers click Home. From the Home page, chapter managers can select chapters to manage and click links to visit the chapter home page, design chapter pages, view and edit chapter members, or send email. This page also displays email statistics about the number of sent, received, and opened email messages.
- **Site Pages** — To preview pages and change the layout and content, chapter managers click Site Pages. Chapter managers can create friendly URLs, select page templates, add pictures, and edit text. Chapter managers can also adjust settings such as whether members can add, edit, and delete events on an Event Calendar. The Site Pages page is available only to Content Managers. If a Content Manager is a member of more than one chapter site, the manager can access multiple chapter pages.
- **Email** — To generate email messages and view statistics, chapter managers click Email. To view email statistics but not recipients, chapter managers click Email Activity. The Email Activity screen displays overall email statistics. A bar chart displays statistics for the email message selected in the Select email to view activity field. Chapter managers can click view email to read the original email message. To send email messages to
chapter members, chapter managers click **New Email**. From the New Email screen, chapter managers select email templates and create the content. The **Send To** field displays the chapter name, but not individual recipients.

<table>
<thead>
<tr>
<th>Screen Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sent</td>
<td>The number of distinct email messages that have been sent, not the number of times those email messages have been sent. For example, if two different messages are each sent to five addresses, the number sent is “2.”</td>
</tr>
<tr>
<td>Number Recipients</td>
<td>How many times distinct email messages have been received. In other words, the number of times that email messages have been sent, minus failed deliveries. For example, if two different messages are each sent to five addresses, the number of recipients is “10.” But if two messages are delivered unsuccessfully, the number of recipients is “8.”</td>
</tr>
<tr>
<td>Number Opened</td>
<td>The number of email recipients who opened email messages. For example, if two different messages are each sent to five addresses but only two are opened, the number opened is “2.”</td>
</tr>
<tr>
<td>Total Sent</td>
<td>The number of times the email message in the <strong>Select email to view activity</strong> field was sent.</td>
</tr>
<tr>
<td>Opted Out</td>
<td>The number of times the email message in the <strong>Select email to view activity</strong> field was not delivered because the recipient requested not to receive the email message.</td>
</tr>
<tr>
<td>Invalid Email</td>
<td>The number of times the email message in the <strong>Select email to view activity</strong> field was not delivered because of an invalid email address.</td>
</tr>
<tr>
<td>Opened</td>
<td>The number of times the email message in the <strong>Select email to view activity</strong> field was opened.</td>
</tr>
</tbody>
</table>

- **Members** — To search for chapter members, chapter managers click **Members**. A query created in Blackbaud CRM defines the members of a chapter. Chapter managers can search by criteria such as name, nickname, gender, and birth date. The Members page is available only to Data Managers. If a Data Manager is a member of more than one chapter site, the manager can access members of multiple chapters.

**Note:** If the Content Manager and Data Manager are contained in the same role, the manager views both **Site Pages** and **Members** on the action bar. If your Content Manager and Data Manager are separate roles, the Content Manager views **Site Pages** and the Data Manager views **Members**.

**Design Chapter Manager**

When you design a Chapter Manager part, the Design tab includes the Manager, Member Search, Member Giving History, Member Profile Editor, and Chapters tabs.
Note: For navigational purposes, make sure you have a link on your website for Content and Data Managers to use that directs the manager to the chapter site. You can add a link using the Chapter Links part, create a chapter search link for your menu, or add a Chapter Console Link in an Action Chapter Page Element. For more information about navigating chapter management, see Design and Management Process on page 1.

For information about the remaining tabs on the Edit Part screen for a Chapter Manager, see the Parts Guide. To design a Chapter Manager, begin with the Manager tab and follow the instructions for the remaining tabs.

Manager tab

1. From the Manager tab, to add a chapter site page, click Add Page. A grid appears.

   ![Add Chapter Site Pages](image)

   a. In the Page column, select the existing page, with a Chapter Page Element, to display on your website.

   b. In the Display Name field, enter a page reference name that chapter managers can easily identify. This name does not appear on your site for public viewing. The name appears as a page option that chapter managers use to select their chapter manager page. For example, enter “Greenville Chapter — Red” in the Display Name field for one page, and enter “Greenville Chapter — Blue” for a second page. When a manager selects to edit his chapter page, these two page options appear for the chapter manager to select from.

   c. If this is the default page, select the option in the Home Page column. Each Chapter Manager part must have a default page.

      To remove the page from your site, click Remove in the Action column.

2. To create email designs for chapter managers to use for sending email, in the Email Designs frame, click Add Email.

   ![Email Editor](image)

   The new email screen appears.
3. In the **Name** field, enter a name for the email.
   The program uses the personal page owner’s email address for the **From Address** field and the owner’s name for the **Name** field.

4. In the box, enter the content of the email. To format the email content’s appearance and layout, use the HTML editor. To customize email content, click **Merge fields** on the Insert tab in the toolbar. For more information about the HTML editor, see the *Program Basics Guide*.

5. To link to a User Email Preferences Form part, click **Insert link** on the Insert tab in the toolbar. Under **Create link to special page** frame, select the User Email Preferences Form for the Chapter Manager part. If it does not exist, you must create the form in *Parts*. For information about how to create a link, see the *Program Basics Guide*. For information about how to create a User Email Preferences Form part, see the *Parts Guide*.

   **Warning:** A link to a User Email Preferences Form part is required for each email design that you create for the Chapter Manager part. This way, members can unsubscribe from the email.

6. In the **Title** field, enter the name of the chapter site search. The title you enter appears first on the chapter search page.

   ![Chapter Manager Email: test](image)

   This search is used by members or anonymous users to search for a chapter page. Also, members can view other chapter members on this screen. If you do not enter a name, Chapter Search appears as the title for the site search screen.

   **Note:** Anonymous users can browse chapter site pages if you add a Menu part to your website that includes a link to the page containing the chapter site search (created in this step). For information about the Menu part, see the *Parts Guide*. Results for anonymous users contain a hyperlink list of chapter names on your website. The chapter site links direct the anonymous user to the chapter home page. If you prohibit anonymous rights to the home page in *Users & security*, the anonymous user is directed automatically to the user sign-up page on your site. This way, you can identify your chapter site users by requiring anonymous users to sign up for your
site if they want to browse your chapter pages.

- **Member Search tab**

  1. In the **Directory Title** field, enter a name for the directory.

  ![Diagram of Member Search tab]

  2. In the **Search Form** frame, in the **Split search fields into** field, select the number of columns of search fields to appear in the criteria table. You can display up to five columns.

     To process a search while the user browses your Directory page, select **Load unfiltered results when this part is loaded**. When you select this checkbox, the Directory search processes before the user enters criteria and clicks **Search** on your website.

  3. When you use the Academic Catalog in Blackbaud CRM, an **Education Fields** section appears. In the **Include** field, select whether to include academic information from affiliated educational institutions only or both affiliated and unaffiliated institutions for the search and results filters.

     **Tip:** To improve search performance, narrow the volume of institutions to search by selecting "Affiliated educational institutions" in the **Include** field. After you save the part, you cannot change your selection in this field.

In addition to this section, more educational fields are available to integrate Academic Catalog data with this part on your website. Under **Available Fields**, in the **Additional Information** nodes for **Primary Alumni** and **Education History**, the **College/School**, **Division**, **Department**, **Sub Department**, and **Degree type** fields appear to support the integration. When you use these fields, website users can search and view the information in the directory display window for affiliated and unaffiliated institutions, depending on the selection you make in this section. For example if you select "Affiliated educational institutions" and include the **Department** field, users can narrow their search by selecting a department.
and then view the information in the search results for affiliated institutions only. Also, you can use the Program and Degree fields under the Primary Alumni and Education History nodes to search and display this data for affiliated and unaffiliated institutions.

**Note:** When you enable or disable the Academic Catalog in Blackbaud CRM and then add or remove Academic Catalog fields on the part for your web page, the changes do not reflect on your website for approximately 20 minutes.

4. In the **Results** frame, set up how to display search results on your Directory page.
   a. In the **Show navigation controls** field, select where the navigation buttons will appear. When the Directory search returns results, the navigation buttons appear “Above the results,” “Below the results,” or “Both above and below the results.”
   b. The Directory search can return up to 500 results that match the criteria entered by a site user. In the **Results per page** field, select the maximum number of results to appear on a page when a site user searches the directory. You can display up to 50 results per page.
   c. In the **No records found message** field, enter the message to appear if no records meet the search criteria that the user enters to search the Directory on your website. By default, the message “No directory entries match your criteria” appears.
   d. To allow website users to send instant messages to constituents in the results, in the **Include a send message link for** field, select the User Networking Manager part to link directory results to.
   e. To allow website users to send personal messages through the selected User Networking Manager part to individual constituents who appear in the results but are not registered users on your website, select **Allow messages to non-users**.

**Note:** When you mark **Allow messages to non-users**, website users cannot send personal messages to a constituent when the constituent opts out of email in **Constituents**.

5. Right-click and drag fields from the **Available Fields** box on the left and drop them in the **Search Form Fields** box on the right. You can also select the field and click the right arrow to move it. Select fields the user can search by, such as **First Name** or **Last name**.

The attributes available in the **Constituent Attributes** tree view are selected on the Settings tab in **Sites & settings**. On the website, multiple-value attribute fields, such as Organization type, become drop-down boxes with the various attributes available as selections.

To arrange the order of fields in the list, click **Up** and **Down**.

**Note:** The fields in the **Search Form Fields** box and the **Listing Fields** box do not have to match.

6. To select the fields that appear when the search finds a match, right-click and drag fields from **Available Fields** to **Listing Fields**.

For example, you select to list the member’s last name, first name, birth date, address, and whether or not they want to receive email. In this case, the last name is the link. When results appear, the last name has a line underneath it and changes color when you move your mouse over it, indicating it is a link. When a website user clicks the last name link, the published profile information for that directory member appears.

**Member Giving History tab**

If you select to include Giving History in your Chapter Manager part, managers can create a Giving History list for individual members on the site.

1. To include giving history information, select **Display Giving History**.
**Note:** Review the table in Chart: Display Profile Update and Display Giving History on page 16 to learn about the features on your chapter pages when you do not select **Display Profile Update** and **Display Giving History**, select both checkboxes, or select one checkbox and not the other.

2. In the **List Name** field, enter the name for the Giving History for your website.

3. In the **Message** box, enter message information to appear below the Giving History name on your site.

4. In the **Filtering Options** frame, to select the filters for giving history information, click **Modify**. You can narrow results by **Gift Types**, **Purposes**, **Designation hierarchies**, and **Appeals**.

5. To include recognition credits in the giving history, select **Include Recognition Credits**.

**Note:** If you select to include recognition credits, revenue without a recognition credit is excluded from the giving history. If you select to filter by designation or appeal, the filter applies to recognition credits. If the revenue has multiple designations, all recognition credits appear. This occurs even if one of the designations is not included in your giving history designation filter.

6. In the **Descriptive Text** field, enter the text to display in the giving history to indicate a recognition credit. For example, enter “recognition credit.”

**Member Profile Editor tab**

If you include a profile editor for the Chapter Manager part, Data Managers can update a member’s profile on your website. The updated profile information downloads to Blackbaud CRM.

1. To include a profile update form for Data Managers, select **Display Profile Update**.
2. In the **Type of Profile** field, select the type of constituents who use the profile form. You can select **Individual** or **Organization**.

3. If you select **Organization**, the **Message to display when there are no organization records** box appears. In the box, enter the message to appear when website users who navigate to a page with the profile form part do not have an organization record or are not a relationship type with **Edit Org Profile** selected on the Settings tab in Sites & settings. For example, enter “There are no organizations associated with your record.”

4. In the **Section** field, select the type of profile design to create. Your options include Bio, Preferred Address, Business, Phones and Email, Spouse, Constituent Attributes, Primary Alumni, and Education Attributes.

   Each Section field option includes fields from the corresponding area in Blackbaud CRM. For example, if you select Spouse, spouse relationship fields appear that are in Blackbaud CRM. When a user enters spouse information on your website, you can download the information directly to the offline spouse fields.
If you select Constituent Attributes, the constituent attributes that appear on your User Profile Form can have multiple values. For example, if your Constituent Attribute is “Mentor,” a Mentor field appears with a drop-down arrow on the profile form on your website. The values from the list are the table entries set up for the attribute in Blackbaud CRM. For Mentor, the values can be Algebra, Painting, or Construction, for example.

**Warning:** For constituent attributes to have multiple table entries on the profile form on your website, you must first make them accessible from The Raiser’s Edge. To do this, select the Settings tab in Administration. For more information, see the Administration Guide.

5. In the Heading field, enter the text to appear at the top of your profile design. For example, you can enter “My Biographical Page” for your biographical profile.

6. Select the fields to appear on your profile design in the grid. For details about the grid, see Chart: Display Profile Update and Display Giving History on page 16.

**Chapters tab**
You can create a chapter based on an existing chapter. To do this, in the chapter list grid, select the chapter to edit. In the Actions column, click Click here to copy this chapter. The Copy screen appears. In the Chapter name field, enter a new chapter name. To return to the Chapters tab, click Save.

1. Click New Chapter.

The Chapter Editor: New Chapter screen appears.

2. In the Chapter field, enter the name of your chapter site. For example, enter “Atlanta.” This field is limited to 40 characters.

3. In the Content Manager Roles frame, click Change to add a role for content managers. The Select Roles screen appears.

   Select the role to add and click Add. The role appears in the Select Roles box. Repeat this step to include additional roles for content managers.

   To return to the Chapter Editor: New Chapter screen, click OK. For more information about roles, see the Users & Security Guide.

4. Repeat Step 3 for the Data Manager Roles and the Member Roles frames.
Before creating a Chapter Manager part, you must create queries for the member role in Blackbaud CRM. To appear in the Member Roles frame, the query must be selected in the Base role membership on a query field in Roles.

Tip: A Content Manager is responsible for tasks such as selecting templates, customizing Chapter Page Elements, and updating content. A Data Manager is responsible for tasks such as updating a member’s profile information and processing giving history information. A Member is a chapter site visitor. For more information, see Chapter Management Roles on page 3.

5. To return to the Chapters tab on the Edit Part screen, click Save.

6. To preview the chapter’s home page, in the Actions column, click Click here to view this chapter’s home page. The designated Home Page appears. If the Content Manager for the chapter has edited the home page, his changes appear on the page.

Tip: The chapter Home Page is selected on the Manager tab on page 8.

To close the preview page, click the X in the upper right corner.

7. Click Save. You return to Parts.

Edit the Chapters tab

1. From the Chapters tab, to search for an existing chapter, enter a partial name in the Chapter Name field. In the Selected Roles box, to search for a chapter that contains a specific role, select the corresponding checkbox for the role.
Tip: If roles do not appear in the **Selected Roles** box, click the **Select Roles** link under the box. A Select Roles screen appears. Select the checkbox for the roles to appear in the **Selected Roles** box. For information about roles, see the *Users & Security Guide*.

2. In the chapter list grid on the right, select the chapter to edit.

3. In the **Actions** column, click **Click here to edit this chapter**. The Chapter Editor screen appears.

4. Make the changes for the **Chapter** name field or the **Roles** frames.

Tip: A Content Manager is responsible for tasks such as selecting templates, customizing Chapter Page Elements, and updating content. A Data Manager is responsible for tasks such as updating a member’s profile information and processing giving history information. A Member is a chapter site visitor. For more information, see Chapter Management Roles on page 3.

5. To return to the Chapters tab on the Edit Part screen, click **Save**.

6. Click **Save**. You return to **Parts**.

**Chart: Display Profile Update and Display Giving History**

Review the following chart to learn about the features on your Chapter Manager part when you do not select **Display Profile Update** and **Display Giving History**, select both checkboxes, or select one checkbox and not the
other.

<table>
<thead>
<tr>
<th>Display Profile Update checkbox selected?</th>
<th>Display Giving History checkbox selected?</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>Results from member search are not hyperlinked.</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Results from member search are hyperlinked. When a member name is clicked, the member profile appears. A manager can update the profile. Also, the manager can access the member’s giving history by clicking <strong>Giving History</strong> in the right corner on the profile page.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Results from member search are hyperlinked. When the member name is clicked, the member profile appears. Managers can update the profile.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Results from member search are hyperlinked. When the member name is clicked, the giving history for the member appears.</td>
</tr>
</tbody>
</table>

### Changes in Blackbaud CRM

Chapter members do not register for the chapter. As explained in Chapter Management Roles on page 3, a user’s constituent record must be in a query from Blackbaud CRM that is contained in a Blackbaud Internet Solutions role. When creating the Chapter Manager part, the role must be selected as either the Content Manager, Data Manager, or Member role. These steps must be performed by your organization for a user to access the chapter site. Therefore, Blackbaud Internet Solutions data does not pass additional data to Blackbaud CRM for processing.

The only exception occurs when a data manager updates a member’s profile. When this happens, a profile transaction downloads the updated profile information to Blackbaud CRM. For more information, see the **Web Transactions Guide**.